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Basics

Send messages via S! Mail, SMS or PC Mail.

Exchange text messages with SoftBank or e-mail

S! Mail compatible handsets, PCs, etc.; attach image or
[Separate sound files etc.
subscription ® 942P is compatible with Graphic Mail
required] (C%P.14-6) and AutoArt (C5P.14-7).

® Send/receive up to 2 MB messages.

Exchange short text messages with SoftBank
SMS h

andsets.

PC Mail
[Setup required] | Send/receive messages via PC mail account.
(C5P.14-25)

@ For more information, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

Operations while Using PC Mail
Setting PC Mail accounts creates account folders in Messaging Folders.
S! Mail/SMS operations may change as a result (C3 P.14-25).

® Messaging functions are also available in Viewer Position. Switching
Normal Position to Viewer Position may end active screen.

IAvaiIabIe Entry Items & Character Entry Limits

Item S! Mail/PC Mail SMS
. :digfellss Available Up to 246 N/A —
s single-byte U021
s Ph alphanumerics/ P le-bvt.
a one 1,|Available | Up to 20 Available| *NI'EOVEE
number L alphanumerics/
recipients e
Up to 1 recipient
Up to 256
double-byte/
Subject Available | Up to 512 N/A —
single-byte
alphanumerics
Up to 70 double-/
Text Available| 30 KB Available| single-byte
alphanumerics®
Attachment | Available| *° N/A —

! SoftBank handset numbers only

2 Phone numbers cannot be used for PC Mail address.

3 When text entry mode (L3 P.18-22) is set to English (160char.), up to
160 single-byte alphanumerics can be entered.

4 Up to 2 MB S! Mail including subject, message text and attachment.
Message size is changeable (Create Msg. Size: [ P.18-21)

> Up to 1 MB PC Mail including subject, message text and attachment.

® Character limit varies with attachment size.
@ Change message type while creating a message (C%P.14-10).




I Messaging Folders & Memory Status

Messages are organized in folders by message type.
® PC Mail Folders: L5 P.14-25

Messaging Folders

Incoming Mail

—
== m e I THNF 1T

"= = == =9 Spam Folder

Create Messages
Save as Drafts
Send Messages Sent/Unsent

CompletelNotcompIeteZI—:-) | Sent/Unsent |

(Y 1-=T 1 )V5 13

! Set Auto-sort messages to specified folders or Spam Folder automatically
(C5P.14-17, P.14-18).

2 When handset is out-of-range or in Offline Mode, outgoing messages are
saved as Unsent until signal becomes available (C% Right).

3 Add up to ten folders (C5P.14-21).

Auto Resend

When handset is out-of-range or in Offline Mode, unsent messages are

saved as Unsent and protected from auto deletion.

When signal returns, messages are automatically sent. Once sent,

messages are unprotected.

@ To cancel Auto Resend: C%P.14-23, P.14-24

@ When Auto Resend (L3 P.18-20) is set to OFF, unsent messages are
not automatically sent. However, messages saved as Unsent while
Auto Resend was active are sent automatically.

Deleting Messages Automatically
When memory for messaging folders is low, old messages are
automatically deleted one by one. Protect important messages from
unintentional deletion (C%P.14-22), or set message deletion settings
(C%P.18-20) to OFF. Messages in Drafts and SMS on USIM Card are not
deleted automatically.

When Messaging Memory is Full

& (Received Full) appears in Standby and no more new incoming
messages are received. Delete old messages in Incoming Mail folder
(C5P.14-23), then retrieve new messages (L5 P.14-16).

M View Memory Status
> (&) » Memory Status

JifPececccccccccccccccccoce
@Mail Security (CFP.12-11)

Buibessa ;
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I Customizing Handset Address

Change your handset mail address (alphanumerics before @)
to reduce the risk of receiving spam. Default account name
is random alphanumerics.

abc123-xyz @ softbank.ne.jp
L Account | | Domain _|
Name Name

(Customize here)

@ For details, visit SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp).

@ Handset mail address cannot be changed in Offline Mode.

® For operations while using Internet: (% P.15-7

1 —» Settings — Custom Mail Address

Handset connects to the Network.
Follow onscreen instructions.

Sending S! Mail & SMS

I Sending S! Mail
® Text entry (C¥P3-2)

Example: Select a Phone Book entry to send S! Mail.

1 Pressand hold Mail size
Address field
Subject field

2 Select Address field —»
Phone Book

3 Select a Phone Book entry —»

Select a SoftBank handset number

or mail address

® Press (O to toggle tabs if both mail
addresses and phone numbers are
saved.

= New S! Mail g8
B <Add Address>
rsubl<Add Subject>
ZH<Add ATCH>

<Input Text>

| ElAutoArt

Composition Window

- ASLEN J2vo]
B <Add_Address>
= Destination Address
[1]Phone Book ]
HSent Address
“ElReceived Address
EMail Group
EEnter Mail Address
[Enter Phone Number

Phone Book

I

| EAEENCN = K|

[l Abe Ichiro

E Aoki Taro
090XXXXXXXX

Tkeda Jiro

A Ishikawa Saburo




4 Select Subject field =
Enter subject

5 Select Text field

6 Enter text

7 (=)[Send]

L New S! Mail
3Aok| Taro

ect>
1<Add ATCH>
|_EH<Input Text>
| “HlAutoArt

b

Text Entry Window

| TelAoki Taro
[sublHel lo

| ZB<Add ATCH>
EIHGB tes

Long time no see. How
lare you doing?

1 am fine as usual.

By the way, can we have
lunch together this
Saturday?

Total size: 381 Bytes|

| Menu |
Foge ¥

® Alternatively, (=) & Create New to open Composition window
® Messages are automatically resent when within range.

P eccccccccccccocccccccoe
@Addresses @Additional Functions (C3P.14-9)
@Sending Options (C%P.14-11)
ETIED @Request Delivery Confirmation @Outgoing Mail Notification
@Auto Resend Unsent Messages (C5 P.18-20)
@Set Reply-to Address @Auto Signature (C3P.18-21)

Adding Attachments

New S! Mail
allAoki Taro

sublHe| |o

B <Add_ATCH>

| —116Bytes

| ElAutoArt

Long time no see. How

lare you doing?

I am fine as usual.

3 ©lsend :

1 After Step 6 (left), select

Attachment field

p) Select a folder in Data Folder =
Select a file

lunch together this
Saturday?

Buibessa .

W Capture Pictures/Videos to Attach

> After Step1, Activate Camera — Photo mode or Video mode —
Frame subject = @[Record], (0) or [J(Ea/®) (> For video,
(e][Stop], (0D or [J(==/®) — (@)[Save], (O or [J(=a/P)
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[_Note |

@ Some files can not be attached depending on the file format or size.

® Some copy protected files can not be sent.

® Attachments exceeding size limit are automatically compressed. (Width
and height of compressed images may change.) If the compressed file
still exceeds maximum size, message cannot be sent.

® Ring Songs&Tones, Music and Videos files cannot be attached directly
from microSD Card. Move files to handset before attaching to

messages.

P eeccccccccccccocccccccoe

@Attachments (C¥P.14-9)
ITID @Attachment Size (C3P.18-20)

Graphic Mail

Create HTML messages; select font color/size, background
color, or insert images, etc.
Example: Use various Templates to create Graphic Mail.

® Change font size

® Scroll text

1 After Step 4 on P.14-5, (x7)[Menu] -
Load Template — Highlight a template —»

([=@)[View] = (@][Select]

® To return to Template list:

Select Text field = Delete "z Z(cxxEHLINTH |

— Font Size O

® Alternatively, (7)[Menu] - m—ll—ev

A i TRTESIEEN
Al &[4 C]

Set Graphic Mail to open Graphic
Palette

Select a font size = Enter text

—» Select area

Place cursor before a sentence
to scroll = (@)[Start] & Move
cursor to end of sentence =
(@)[End]
Text is highlighted. '
® To cancel selection: @

Set Scrolling — (x7)[Exit]




== Edit P[gview

8 (/@) to preview =
® Alternatively, (37)[Menu] —
Preview to view text field

9 (@)[Set] - (=)[Send]

M Reset Operations

> To cancel previous operation: Close Graphic Palette = (7)[Menu] —
Undo

> To reset all Graphic Mail operations: —» Graphic all reset — YES —
YES

M Use Mail Art
> In text entry window, —> Mail Art = Select an item — [Exit]

[ Use Files Saved in microSD Card
> In text entry window, —> Insert files — File Select &
Select a folder — (&)[microSD] — Select a folder — Select a file

P ecccccccccccccccccccoe

@Use Other Graphic Mail Settings (C3P.14-10)
@Download Templates via Internet (L3 P.14-11)

AutoArt

AutoArt converts S! Mail to HTML mail and automatically
adds pictographs and background color.
@ To change font size/color by AutoArt: L3 P.18-21
After Step 6 on P.14-5, AutoArt —» Select an item (See
below)

Item Operation/Description
Automatic  Automatically adds art
Happy, Sad,  Automatically adds art corresponding to the

Like, Angry or selected mood
Surprised

Converted message appears.
® To cycle next/previous selections: (x7)[Next]/(=2)[Prev.]
@ To cancel and return to Composition window: ez —»

y (@)[Set] - (=)[Send]

® Alternatively, (7)[Menu] = AutoArt in Composition window after
entering text

® Use AutoArt to automatically add art in Graphic Mail.

® AutoArt cannot be canceled after pressing (@)[Set] in Step 2.

P eccccccccccccocccccccoe

GITIED @Set Preference for Amount of Pictographs in AutoArt
@Background Color Function (AutoArt) (C%P.18-21)

Buibessa .
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I Sending SMS Messages

® Text entry (C3P.3-2)

Example: Select a Phone Book entry to send SMS.

1 @~

Select Address field —»
Phone Book

Select a Phone Book entry =
Select a SoftBank handset number

|ty New SMS

Address field —{ Tl TNNIEES)
Create New SMS [EE—J;“" ut Text)
Text field

| Send [RRSRSEEA Henu |

Composition Window

[1/Phone Book ]
HSent Address
EReceived Address
EDirect Entry

[c] Phone Book

Q| wh
| RN = B0

@ Abe Ichiro
EAoki Taro
090XXXXXXXX
Tkeda Jiro
HIshikawa Saburo

4 Select Text field

5 Enter text

® \When number of entered character
exceeds limit, S! Mail conversion option
message appears.

6 (=)[Send]

abe %2.Sm
| Hode |

| Henu |
Text Entry Window

® \When a single-byte text message including | {} [ ]~/ is sent or a draft
including such text is edited, some characters may be cut out of text
field.

® Messages are automatically resent when within range.

P eccccccccccccocccccccoe

@Addresses @Additional Functions (C%3P.14-9)

GITTD @Request Delivery Confirmation @0utgoing Mail Notification
@Auto Resend Unsent Messages (C5 P.18-20)
@Change SMS Center Number @Default Text Entry Language
(C%P18-22)



I Creating Messages

Addresses

(From Jp Composition window, select Address field

M Enter Address Directly

>SS! Mail: Enter Mail Address or Enter Phone Number —» Enter a
mail address/SoftBank handset number

> SMS: Direct Entry — Enter a SoftBank handset number

I Select Address from Sent Address/Received Address Logs
> Sent Address or Received Address —» Select a log = @[Select]

M Select S! Mail Address from Mail Group
> Mail Group — Select a Mail Group

W Add/Edit/Delete Address
> Follow the steps (See below)

Item Operation/Description

Add > <Not entered> — Search/enter address —» Select an

recipients* address or enter directly = (=)[Finish]

Edit >S1 Mail: Select an address —» Edlit —» Edit address =
(&)[Finish]

> SMS: Select an address = Direct Entry — Edit

address

Delete* > Highlight an address = (x7)[Menu] =
Delete receiver & YES — (=)[Finish]

* S Mail only

M Change To/Cc/Bcc (S! Mail only)
> Highlight an address = (%7)[Menu] — Destination types — Select a
type = (=)[Finish]

Attachments

((From )p After attaching a file, select Attachment field

I Open/Play Attached Files
> Select afile

M Add Attachments
> [Menu] —» Add Attached Files — Select a folder = Select a file =
(=)[Finish]

® To capture still images or videos to attach: C%P.14-5

I Delete Attachments
> Highlight a file = (37)[Menu] — Del Attached Files - YES

Additional Functions

M Look Up Words from Text Entry Window

> In S! Mail text entry window, (37)[Menu] —» Look up in dict.
— Move cursor before/after word = (@)[Start] = (] to highlight the
word = (@)[End] = Read disclaimer & OK

® Dictionary operations: L3 P.13-13

Buibessa ;
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M Functions Available in Composition Window
> In Composition window, [Menu] —> Select an item (See below)

I Graphic Mail Functions

I Use Other Graphic Mail Settings
>1In S! Mail text entry window, — Select an arrange item (See below)

Item Operation/Description
Insert files Insert still images, music or Flash® files; activate Camera
and insert captured image
Music files are sent as BGM
> Select an item
- File Select — Select a file type —» Select a folder
—» Select a file
- Camera —» Frame subject — @[Record] -
(e)[Save]
® To delete inserted music files: Delete BGM — YES
Font Color > Change font color
Background > Change background color
color
Insert Lines  Insert separator line
Mail Art Insert Mail Art
> Select a file
Graphicall  Cancel all Graphic Mail Settings
reset >YES
Selectarea  Specify text to be arranged
> Place cursor before/after text = (@)[Start] -
(029 to highlight area — (@)[End] — Select other
items —» Follow the steps for selected items
® To cancel selection: (@)[End] = (@)
Font Size > Change font size

Item Operation/Description
Send Send message
Preview Preview message
AutoArt! (CFP14-7)
Save as Save message to Drafts without sending
Drafts
Attached View attached file list
files'
Load > Select a template
Template'
Save Save edited template
Template' >YES
Add Add signature
Signature' ® (reate and save signature beforehand (L% P.18-21).
Send (CZP14-11)
Settings'
14 Image Set image compression size for attachment
= Compression' > Select a size or OFF
o Create Msg. 300KB or 2MB
é Size'
3 Confirm (CFP14-11)
Delivery’
Input Select character input mode
character? > Japanese or English
Change mail  Switch mail type
type > Select an item
!SI Mail only
2 SMS only

14-10




Item Operation/Description

Select Flash text

Blinking

Set Scrolling  Scroll text

Set Swinging Swing text

Alignment > Select a type

® One file of music or Flash®, and up to 40 types of My Pictograms or
images can be inserted per Graphic Mail.

® To delete inserted images, lines, Mail Art, etc.: Close Graphic Palette —»
Move cursor before images, etc. =

@ Ring Songs&Tones or Music files cannot be inserted directly from
microSD Card. Move files to handset beforehand.

I Save Edited Templates
> In S! Mail Composition window, (37)[Menu] —» Save Template —
YES

Il Download Templates via Internet
> (=) & Templates - Download Templates — YES
@® Handset connects to the Network. Follow onscreen instructions.

I Sending Options

(From » Composition window, (x7)[Menu]

M Confirm Delivery
> (For S! Mail, Send Settings —) Confirm Delivery — ON
@ Request Delivery Confirmation (C%P.18-20)

I Notify Recipients of Message Priority Level (S! Mail only)
> Send Settings —» Priority — Select a level

I Set Reply-to Address (S! Mail only)
> Send Settings — Set Reply-To = ON
@ Specify reply-to address beforehand. (C3P.18-21)

Buibessa ;
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Receiving & Viewing Messages

Retrieving S! Mail Automatically

Auto Download retrieves up to 1 MB messages. Transmission fees are
incurred; adjust to use. (To disable Auto Download/limit message size for
Auto Download: C3P.18-21)

I Opening New Messages

When a new message is received, Yi g
M and Information window opens in
Standby.

7/2AESat)

Information
EiNew message 2

1 In Information window,
New message

Newest message appears.

® Press (0] to show previous/next message. |Long time no see. How
lare you doing?
I am fine as usual.
By the way, can we have
lunch together this
Saturday?

(el Suzuki Goro
(suslHel o
[ 28No Attachment File

Message Window

14-12

@ [f an incoming S! Mail has more than one recipient, select
Display Address in Message window to view recipient list.

® Handset may connect to the Network via URL link in message text.
Data-intensive web pages may incur high charges.

® Incoming message window may not appear; message tone and
Notification Light may not always sound/illuminate.
M flashes to inform of a new message.

@ |nformation window disappears even when an unread message other
than latest message is selected.

Tio EEEEEEXEEXEEEEEEEFF X ENXKY)

@Setting Secret Mail (C%P.12-11)

@Retrieving/Viewing Messages (C5P.14-16)

@D @Ringtone @Ringer Volume @New Message Ringtone Duration
@ Vibration (C¥P.18-2)
@Set Notification Light by Incoming Type (Voice/Video Calls or
Messages) (C¥P.18-10)
@Show/Hide Incoming Mail Notification @Incoming Mail Display
(C5°P.18-20)
@Maximum Incoming Message Size @Limit Auto-retrieval by
Message Type (C3P.18-21)



I Window Description

Il Messaging Folder Contents
Received Date & Time',
Sender? and S! Mail Subject
(For SMS, Message Text)

@ For Sent/Unsent, following

4

7/24 Keitai Taro

Happy

E - |7/24 Shirato Hanako
How are you?

appear: @® 7/24 Suzuki Goro
. .
s Sen.t c'iate/tlme Example: Received Folder
Recipient in Incoming Mail
Message Type/Status
Message Type Message Status
(=0/® Unread/Read S! Mall &y Attachments
/@ Unread/Read S! Mail @ (Silver) Protected
Notice I%,_ Forwarded Message
[:0/® Unread/Read SMS &1 Replied Message
L9/ Unread/Read USIM X Failed
Card SMS (Sent/Unsent Message)
= Forwarded Server Mail

I Resend Scheduled

New Delivery Report
(Sent/Unsent Message)

High Priority

GO

Low Priority

Il Message Contents

Sent or Received

i = Rovd. Msg. Ui3— Number/All Sent or
Dateleme. . £ C82010/7/24 10:10 Received M
Sender/Recipient — o Suﬂlki Goro ecelved Messages

i subHel lo
SUb]ed [ Z8No Attachment File

Long time no see. How
are you doing?

I am fine as usual.
By the way, can we have
lunch together this

Saturday?

Message Text

Message Window

Number of Attachments
The number of files (images, sounds, videos, text, etc.) appears.

_Note |

® Status indicators for forwarded/replied SMS messages (saved in USIM
Card) do not appear.

® After retrieving complete messages, S! Mail Notice icons with
IS (Forwarded) or +f#] (Replied) change to =7/ ®(SI Mail).

® Messages remain protected after complete messages are retrieved via
protected S! Mail Notices.

® |f messages on microSD Card do not appear correctly (C% P.10-20),
copy messages to handset (C3P.10-21) and execute Charset
Conversion (C3P.14-24).

JifPececccccccccscocccccccoce
@Functions Available from Message List (C%P.14-22)

@Functions Available in Received/Sent Message Window (C%P.14-23)
GITTD @Font Size (C¥P.18-20)

Buibessa ;
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I Retrieving Complete S! Mail

The complete message may not be downloaded during
handset operations. Center sends initial portion of message
as an S! Mail Notice. Manually retrieve the complete
message.

= Revd. Msg.
L382010/7/24 10:10
(Fram Suzuk i Goro
[ 28No Attachment File

Select continue (xxxKB) at end of
S Mail Notice

® (xxxKB) is an estimated Server Mail size;
may differ from actual message size.

Long time no see. How
are you doing?

By the way, can we have
lunch together this

enu |

I Retrieve from Message List
> In received message list, [Menu] — Retrieve —» This one

M Retrieve Multiple Messages
> In received message list, (7)[Menu] — Retrieve — Selected —
Check messages —» (=2)[Finish] = YES

14-14

I Opening & Saving Attachments

1 InMessage window,
(x7)[Menu] = Attached files

2 Select a file

File plays or shows.

3 After viewing,

Attached files window returns.

Mail Information

Attached files

4
[
a
z
cf8]
8l

4 Tosave the file, highlight file —
(=)[Save] » YES -
Select a folder

@ \When messages are opened, attached image files appear/play
automatically.

® {7 (Silver) appears with file requiring a Content Key. If Content Key has
expired, warning appears when opening a file. Acquire new Content
Key (C%P.10-5).

® Incompatible files are saved to Other Documents in Data Folder. Some
files may not be saved to handset.

File Formats Supported by Auto Playback
® |mage files (JPEG, GIF, PNG)
® Music files (SMAF, AMR, SMF, SP-MIDI)

JifPececcccccccccccccccccoce
ETIED @Auto-play Attached Music Files (C%P.18-21)



I Showing Sent/Received Mail Address

1 Sent Address
Press and hold (o

Received Address

Press and hold (o)

[=8M8] : SMS (successfully sent)

- SI Mail (successfully sent)

® To show Redial/Incoming Call Logs: (&)[Change]

7 Toview entry details, select an entry
® To send S! Mail/SMS to recipient shown: (@) BEIl] — Mail
composition operation (S! Mail: £ From Step 4 on P.14-5 or SMS:
% From Step 4 on P.14-8)
® To save to Phone Book: (&)[Store] — Operation for saving to
Phone Book (L% From Step 2 on P.4-5)

P ececccccccccccocccccccoe
@Sent/Received Address ([ P.14-21)

I Using Server Mail

Retrieve mail list stored at the Center to view Server Mail.

Viewing Server Mail List
1 — Server Mail

p) Retrieve Mail List = YES

M Update Server Mail List
> After Step, Retrieve Mail List & (=)[Update] - YES

Retrieving Server Mail

1 —» Server Mail = Retrieve Mail List
® [f no Server Mail is in the list, YES & OK

Retrieve a New Message
Select an S! Mail

Retrieve Multiple Messages
[Menu] —> Retrieve — Retrieve Selected —
Check messages — (=2)[Finish] = YES

I Retrieve All Messages
> (=) - Server Mail — Retrieve All

Buibessa ;
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Deleting Server Mail
1 —> Server Mail = Retrieve Mail List
2 (x7)[Menu] - Del Server Mail

Delete a Message

Delete This = YES

Delete Multiple Messages
Delete Selected - Check messages — (=2)[Finish]
- YES
M Delete All Messages
> (=) - Server Mail = Delete All = Enter Phone Password = YES
JifPecccccccccccccccccccoce

@Mail Security (CFP.12-11)
@Server Mail Functions (£ Right)

14-16

I Retrieving/Viewing Messages
Manually Retrieving New Messages

Retrieve S! Mail messages saved on Server while handset is off/out-of-range.
> (=)  Retrieve New

Server Mail functions

(From J» - Server Mail

I Forward Server Mail

> Retrieve Mail List — Highlight a message — (x7)[Menu] =
Fwad Server Mail — Select Address field = Search/enter address —»
Select an address or enter directly & (=)[Send]

@ To forward Server Mail from S! Mail Notice: In Message list, highlight
S! Mail Notice = (x7)[Menu] = Forward — Fwd Server Mail -
<Add Address> — Select/enter and address & (=)[Send]

® Forwarded S! Mail messages remain in Message List.

® = appears for forwarded messages in Drafts or Sent/Unsent.

M Sort Server Mail
> Retrieve Mail List & (x7)[Menu] = Sort — Select a condition

M View Server Mail Information
> Retrieve Mail List — Highlight a message — (7)[Menu] =
Mail Information

I View Server Mail Memory
> Server Mail Memory



Organizing/Using Messages
IChecking Messages in Messaging Folders

® At time of purchase, information message is provided for your
convenience (Transmission fee does not apply).

1 —> Incoming Mail, Drafts, |: _ lMessasing _»
Sent/Unsent [ Incoming Mail @ |

¥ Create New
® ([ appears for unread messages in = Retrieve New

Incoming Mail folder. BV L
U appears for draft or unsent messages ool

. B Sent/Unsent J
in Drafts or Sent/Unsent folder. CS T

® In Incoming Mail or Sent/Unsent folder,
select a folder then message.
® Messaging Folders: 5 P.14-3

™ Create New PC Mail
% Create New SMS
& Settings

1»

2 Select a message
@ To toggle previous/next messages in Received/Sent Message
window: (o)
P ececcccccccccccccccccece

@Functions Available in Incoming Mail or Sent/Unsent Folder (C3P.14-21)
@Functions Available from Message List (C%P.14-22)

I Setting Filters (Auto-sort)

Filter messages into folders by criteria.

® Previously sent/received messages are not filtered.

® \When a message meets multiple criteria, message is filtered according to
following priority:
Subject = Address = Mail Group = Phone Book group

® Set up to 30 criteria per folder.

1 — Incoming Mail or Sent/Unsent

7 Highlight a folder —» (7)[Menu] -
Auto-sort Setting

3 (@[Menu] - Select an item (See below)

Item Operation/Description

Add Subject Filter messages by subject
> Enter a subject

® SMS cannot be sorted by subject.

Add Address Filter messages by address

> Search/enter address — Select/enter an address

Add Group  Filter messages by Group in Phone Book
> Select a group

Add Mail Filter messages by Mail Group

group > Select a Mail Group

M Edit Sort Conditions
> After Step 2, highlight an item —» (@)[Edit] = Edit subject, address,
Group or Mail Group

Buibessa ;
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M Change Auto-sort List View
Switch Name view or Address view for Auto-sort.
> After Step 2, (7)[Menu] = Address Display — Name or Address

M Delete Auto-sort Settings
> After Step 2, (highlight an item =) (x7)[Menu] = Delete or
Delete All (—» For Delete All, enter Phone Password) = YES

[ Re-sort Set Folders

> To re-sort messages in a specific folder: In Step 2, highlight a folder =
(x7)[Menu] = Re-sort in This = YES

> To re-sort messages in all folders: After Step 1, (3)[Menu] =
Sort in All > YES

14-18

I Filter Spam

Sort messages from unknown senders into Spam Folder
without incoming notification. Use Safe List to receive
messages from certain addresses/phone numbers and
domains.

® Messages from secret Phone Book entries may be sorted into Spam
Folder. Be careful when deleting messages from Spam Folder.

Setting Spam Folder

<Default> OFF

1 — Settings —» Universal Settings —
Anti-Spam Measures

9 Spam Filter = Enter Phone Password

3 ON — YES




Safe List

® Specify up to 20 addresses and domains (for example, @softbank.ne.jp)
to receive messages from without sorting into Spam Folder.
1 —> Settings — Universal Settings —»
Anti-Spam Measures — Safe List

2 Add Addresses
(x7)[Menu] - Add Address = Received Address
or Direct Entry —» Select or enter an address

Add Domains
(x7)[Menu] - Add Domain — Enter a domain

3 (&2)[Finish]

M Edit Saved Addresses
> After Step 1, highlight an address = (@)[Edit] = Edit address

M Delete Addresses
> After Step 1, (highlight an address —») [Menu] — Delete or
Delete All (= For Delete All, enter Phone Password) = YES

P eeccccccccccccocccccccoe
@Report Spam (C5P.14-24)

I Replying to Messages

i it} Reply mail ]
1 InMessage window, (=J[Reply] Ee o
. i i e. Hello
Re: appears k?efore Subject vvheln replying to %W
S Mail. Received message text is quoted. B 140Bytes
| AutoArt

® Replying to S! Mail with multiple
recipients: In Message window,
(=2)[Reply] — Reply to Sender or
Reply to All

Long time no see. How

are you doing?

I am fine as usual.

By the way, can we have
lunch together this

Saturday?

Total size:

Send

409 Bytes|

| Menu_|
Page V|

7 Complete message — (=)[Send]

M Reply without Quoting

> In Message window, (37)[Menu] = Reply — Reply to Sender or
Reply to All > Compose S! Mail or Compose SMS

® Selectable items differ by mail type.

® Alternatively, reply from Message List window without opening
messages (CFP.14-22).

P ececcccccccccccccccccoce
@Quote Original Message in Reply (L3 P.18-20)

Buibessa ;
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I Using Mail Groups

Save mail addresses by group. Messages can be sent to
specified group of recipients.

@ Save up to 20 recipients per group.

® Create up to 20 groups.

Creating Mail Groups

Main Menu > Phone p> Settings P> Mail Group

1/2

Mail group

1 Select a group to save

il Group 2
EIMai | Group 3
EMai | Group 4
EIMai | Group 5
E@Mai | Group 6
[E@Mai | Group 7
EIMai | Group 8
EMai | Group 9
[@Mai | Group 10
EdMai | Group 11

Enter Mail Address Directly
Highlight <Not stored> —
(&)[Edit] — Enter mail address

Select Mail Address from Phone
Book or Sent/Received Address Logs

14 T EMai | Group 12
Highlight <Not stored> — Group 13

3 (x7)[Menu] = Look-up address

é_ — Select an item — Select an Mail Group List

@ entry

@ Repeat Step 2 to save mail addresses.
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M Change Group Names
> In Step 1, highlight a Mail Group — (37)[Menu] =
Edit group name —» Edit name

I Reset Group Names
> In Step 1, highlight a Mail Group = (37)[Menu] -
Reset group name — YES

M Edit Mail Addresses
> After Step 1, highlight a mail address = (=)[Edit] — Edit

M Delete Saved Mail Addresses
> After Step 1, (highlight a mail address =) (37)[Menu] —

Delete this or Delete all (— For Delete all, enter Phone Password) =

YES

I Send a Message to All Group Members

> In Step 1, highlight a Mail Group — (=) IE<H]
® To select a Mail Group from S! Mail Composition window: £ P.14-9



I Sent/Received Address

> Sent address logs: Press and hold (0 = Highlight an address —
(7)[Menu] = Select an item (See below)

> Received address logs: Press and hold o) = Highlight an address —
[Menu] — Select an item (See below)

I Organizing Messages

M Functions Available in Incoming Mail or Sent/Unsent
Folder

> (&) —» Incoming Mail or Sent/Unsent = (Highlight a folder —)
[Menu] — Select an item (See below)

—
Buibessaj N

Item Operation/Description Item Operation/Description
Character Toggle font sizes Add folder ~ Add up to 10 user folders to each of Incoming Mail and
size Sent/Unsent folders
Add to Phone Save selected mail address/number to Phone Book > Enter folder name
Book (% From Step 2 on P.4-5) Edit folder > Edit folder name
Add shortcut Create a shortcut (3 P.1-21) Select a shortcut in Standby name*
icon to open Composition window with selected mail address/ Auto-sort > Sort messages (L% From Step 3 on P.14-17)

number in Address field Setting*
Compose Create a message to selected address/phone number Re-sort in Re-sort messages in selected folder
message (C% From Step 4 on P.14-5) This >YES
Compose Create SMS to selected phone number (C% From Step 4 Sort in All Re-sort messages in all folders
SMS on P.14-8) >YES
Dialing > Select a dialing method —» Dial Sort folder*  Sort user folders
Dialed calls' Show Redial logs > Select a target location
Received Show Incoming Call Logs Mail Security Set to require Phone Password for opening a folder
calls? > Enter Phone Password
Delete this > YES ® To cancel: repeat the step
Delete > Check logs to be deleted = (=)[Finish] = YES Delete* = Enter Phone Password — YES
selected folder
Delete all > Enter Phone Password = YES *A—Y—=T%)L% only

! Sent address logs only
? Received address logs only
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I Functions Available from Message List
> —» Incoming Mail, Drafts or Sent/Unsent (— Select a folder) =
Highlight a message —» (xx7)[Menu] = Select an item (See below)

Item

Operation/Description

Item

Operation/Description

Edit’

Edit message to send
(S! Mail: £% From Step 2 on P.14-4/SMS: C% From Step 2
on P.14-8)

Mail history'* Show up to 1000 sent/received mail records

> Select a sender/recipient address

® (-] or ;=) appears.

® Select a record to show Message window. Press
to return to previous window.

Send’

Send Drafts

Retrieve’

Retrieve complete S! Mail
> This one or Selected (= For Selected, check
messages —» (=2)[Finish] = YES)

Reply?

Reply without quoting message

> Reply to Sender or Reply to All = Select an item —
Compose a message (S! Mail: % From Step 4 on P.14-5/
SMS: % From Step 4 on P.14-8)

® Selectable items differ by mail type.

Dial > Select an item = Make a call/compose a message/add
to Phone Book

Add Save addresses to Phone Book

Address' ® > Select phone number or mail address —» YES
(C% From Step 2 on P.4-5)

Protect/ Protect received/sent messages

Unprotect'

> This one or Selected (= For Selected, check
messages — (=2)[Finish])

® To unprotect: Repeat the step

® SMS saved in USIM Card cannot be deleted.

Reply with
Quote’

Quote received message to reply

> Reply to Sender or Reply to All -
Select an item = Compose a message (S! Mail:
% From Step 4 on P.14-5/SMS: % From Step 4 on
P.14-8)

® Selectable items differ by mail type.

Forward®

—
Buibessa N

> Forward or Fwd Server Mail — Select Address field
— Search/enter address — Select an address or enter
directly = (=2)[Send]

® Forward Server Mail (C%P.14-16)

® When forwarding S! Mail, Fw: appears before Subject.
Dotted line appears in the first line of Text field.

® Attachments are also forwarded. (Messages with copy
protected attachments may not be forwardable.)
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Move' * Move messages to specific folders
> Move This or Move Selected (— For
Move Selected, check messages — (=)[Finish] —
YES) = Select a folder
® SMS saved in USIM Card cannot be moved.
Delete > Select an item —» Operate selected item
® |f messages are received while selecting multiple
messages, message deletion may fail.
Confirm View Delivery report
Delivery'
Send Ir data (C%P.11-3)
IC (CFP.11-5)
Transmission
Copy to Copy messages to microSD Card
microSD >YES




I Using Messages

M Functions Available in Received/Sent Message Window
> In Message window, (7)[Menu] = Select an item (See below)

Item

Operation/Description

Retrieve'

Retrieve complete S! Mail

Edit?

Edit message to send
(S! Mail: £ From Step 2 on P.14-4/SMS: [% From Step 2
on P.14-8)

Item Operation/Description
Copy to Copy SMS to USIM Card/handset
USIM/Copy to > YES
Phone’

Move to Move SMS to USIM Card/handset

USIM/Move > YES

to Phone®

Mail View detailed information (Subject, From, To, etc.)
Information

Unread/ Switch status to Unread/Read

Read’

Release Cancel Auto Resend

Resending'

Sort Change display order

> Select a display order

Reply'

Reply without quoting message

> Reply to Sender or Reply to All = Select an item —
Compose a message (S! Mail: £% From Step 4 on
P.14-5/SMS: C% From Step 4 on P.14-8)

® Selectable items differ by mail type.

! Sent messages only
? Drafts only
3 Received messages only

Reply with
Quote!'

Quote received message to reply

> Reply to Sender or Reply to All &
Select an item = Compose a message (S! Mail:
% From Step 4 on P.14-5/SMS: C% From Step 4 on
P.14-8)

® Selectable items differ by mail type.

Forward'

> Forward or Fwd Server Mail
® Forward Server Mail (C%P.14-16)

Mail history

Show up to 1000 sent/received mail records

> Select a sender/recipient address

® -] or ;=) appears.

® Select a record to show Message window. Press
to return to previous window.

Buibessa ;

Dial

> Select an item —» Make a call/compose a message/add
to Phone Book
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Item

Operation/Description

Item

Operation/Description

Add Address  Save addresses to Phone Book Add to Phone Save highlighted phone number/mail address to Phone
> Select phone number or mail address = YES Book Book
(C% From Step 2 on P4-5) >YES
Protect/ Protect received/sent messages (C% From Step 2 on P4-5)
Unprotect @ To unprotect, repeat the step. Attached files Show attached files
® SMS saved in USIM Card cannot be deleted. Save Save edited templates
Move Move messages to specific folders Templates >YES
> Select a folder Add Shortcut Create a shortcut (% P.1-21). Select a shortcut in
® SMS saved in USIM Card cannot be moved. Icon Standby to open Composition window with selected mail
Delete > Select an item —» Operate selected item address/number in Address field
Confirm View Delivery report Copy Copy address, subject or text
Delivery’ Select an item = Copy (C% From Step 2 on P.3-9)
Send Ir data (C%P.11-3) Look up in  Look up a word in dictionary
IC (C5P.11-5) dict. > Move cursor before/after text = (@)[Start] = (o to
Transmission highlight target area = (®)[End] = Read disclaimer
: - 0K
g::?x);% C>0F;/yf?essages to microSD Card ® Dictionary operations (C%P.13-13)
Copy to Copy SMS to USIM Card/handset Font Size > Select a size
14 USIM/Copy to > YES Scroll Unit Change scroll unit
= Phone' > Select an item
g Move to Move SMS to USIM Card/handset Charset Convert characters when not properly shown
S USIM/Move > YES Conversion' > Select an item
3 to Phone' Report Spam' Report received mail as Spam
Mail View detailed information (Subject, From, To, etc.) > (=)[Send]
Information ® Change destination to report to (C%P.18-20).
Release Cancel Auto Resend ! Received Message window only
Resending? 2 Sent Message window only
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PC Mail

Send/receive messages via PC mail account. Set PC mail
account in advance.
@ Set Yahoo! Mail address: C5P.14-26

Notes

@ Receiving PC Mail for the first time after setting PC mail account may
incur high packet transmission fees.

@ Using auto-receive settings may incur high packet transmission fees.
Be careful when using handset abroad.

® Checking for new messages may slow down other functions.

® Checking for new messages incurs packet transmission fees even
when no new messages are received.

@ Single-byte katakana and pictographs are not supported in PC Mail.

@ PC Mail Account set to handset is not deleted when inserting a
different USIM Card.

Using S! Mail/SMS with PC Mail

S! Mail/SMS operations may change after PC mail account setup.

Example:

® To create S! Mail: Press and hold (=) = S! Mail

® To attach files to S! Mail: Highlight a file = Attach to message
—> S! Mail

@ To view received messages: —» Incoming Mail = S! Mail/SMS
—» Select a folder = Select a message

I Messaging Folders

PC Mail folders are added in Incoming Mail and Sent/Unsent

folders once account setup is complete.
@ Create up to three PC Mail folders.
® PC Mail is not sorted as Spam Mail.

Messaging Folders

Sent/Unsent
S! Mail/SMS
Sent/Unsent

1-Y=7x )5 13"

Incoming Mail
S! Mail/SMS
Received
1-¥-71)L5 1-3*
Spam Folder

Account Name (PC Mail)
Received

1-H=T7#)IF 1-3*

Account Name (PC Mail)

1-H=T7#)IF 1-3*

* Add up to 10 1—1—2T #JL¥ (user folders): CFP.14-21

@ Functions available in S! Mail/SMS (Auto-sort Setting, Mail Security,
etc.) are also available in PC Mail (Some unavailable functions do not
appear in menu).

Buibessa ;
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I PC Mail Account Setup

Set up accounts to use PC Mail.

@ Set up to three PC mail accounts.

® Check ISP information in advance.

@ PC Mail services may not be available depending on services, settings,
contract details for PC mail account.

® Set Quick Yahoo! Mail is available for setting your Yahoo! account.

— Settings — PC Mail Settings —»
Account Settings
2 <Not Recorded> — Select an item (See below)

Item Operation/Description
Account > Enter an account name
Name
Incoming > Select an item = Enter/select an item
Options ® User Name, Password and Receiving Server are
required.
Sending > Select an item = Enter/select an item
Options ® Mail Address and Sender Server are required.

@ To confirm settings: In Incoming Options/Sending Options window,
(=)[Conf] &

® After information is entered in Incoming Options/Sending Options,
to return to Account Settings window.

3 (=[Finish] - 0K

@ To retrieve new messages immediately, select YES
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M Quick Yahoo! Mail Address Setup
> After Step 1, Set Quick Yahoo! Mail — YES or NO
@ Follow onscreen instructions.

M Set Default Account
> After Step 1, highlight an account = (37)[Menu] — Default account
® Sk appears for selected account.

I Delete Account
> After Step 1, highlight an account = (37)[Menu] — Delete account
—» Enter Phone Password = YES

Tip K EEEE NN NN N NN NNNNNNNENNN]
@Reset All Incoming Message Logs @Delete All Server Mail (C%P.14-27)

I Sending PC Mail

@ Default account (£ Above) is automatically selected.

1 Press and hold

— PC Mail

PC Mail Composition window appears.

Account field

<Add Address>
| subJ<Add Subject>

| H<Input Text>

2 Compose a message and send

(C% From Step 2 on P.14-4) PC Mail
Composition Window
I Change Account

> After Step 1, select Account field = Select an account

® Alternatively, open PC Mail Composition window from
—> Create New PC Mail




I Retrieving/Viewing PC Mail

@ |f auto-retrieve setting is on, open new PC Mail from Information:

C¥P14-12

PC Mail Indicators

=1/®  Unread/read PC Mail
i7/® Unread/read PC Mail (notice only)

® When Center sends initial portion of PC Mail, manually retrieve the
complete message.

Retrieving PC Mail by Account

1 — Retrieve New — Select an account

Viewing Previously Retrieved PC Mail

1 — Incoming Mail = Select an account —
Select a message

Tip KEEXEENENNENNENNNNNNNNNNNY
T @Auto-retrieve for New Messages @Set Auto-retrieve Interval/

Condition @Auto-retrieve (while Abroad) @Disable Auto-retrieval
between Set Time Period (C%P.18-22)

I PC Mail Functions

W Attach Image/Music Files
> Highlight a file & (37)[Menu] — Attach to message —» PC Mail —
Compose a message and send (% From Step 2 on P.14-4)

I Reset All Incoming Message Logs

> (=) - Settings —» PC Mail Settings —» Account Settings —»
Select an account — Server Maintenance — Reset Mail Log —
YES

M Delete All Server Mail

> (=) > Settings — PC Mail Settings —» Account Settings —»
Select an account —» Server Maintenance — Delete All — Enter
Phone Password — YES

® |f over 10001 messages are on your PC mail server, retrieving/deleting
messages from that PC Mail account is disabled.

Buibessa ;
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